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to bring it to the front, but it keeps the workspace tidier if we close data sets and output 
after we have viewed them.  

Display 1.10  Imported Version of Water Data 

   
 

In addition to being able to import data from text files, SAS Enterprise Guide can also 
import data from several popular Windows programs such as Microsoft Excel and 
Microsoft Access. As a simple example, the file c:\saseg\data\usair.xls contains a 
Microsoft Excel workbook with some data on air pollution in the USA. The data are 
described more fully in Chapter 6 (Exercise 6.4) but need not concern us here. To import 
the data: 

1. Select File Import Data Local Computer. 

2. Browse to c:\saseg\data. 

3. Select usair.xls and Open. Because the file contains more than one worksheet and 
only one can be imported at a time, a window like that in Display 1.11 pops up to 
select the worksheet to use.  

4. Select USAIR and then Open. The worksheet contains the variable names in the first 
row. SAS Enterprise Guide has recognized this and set the options under Region to 
import and Column Options appropriately, so no changes are needed. 

5. Run the task. It is worth noting that the ease of importing the data is due to the fact 
that the spreadsheet contains only the variable names and the data values. It would be 
simpler again if the file contained only a single worksheet.  
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Importing a data table from an Access database would be very similar. It may also be 
possible to open or import data (File Open Data or File Import Data) from other 
proprietory databases, if the appropriate component of SAS (a module of SAS/ACCESS) 
has been licensed for the computer running SAS. 

Display 1.11  Table Selection Window 

   

1.5  Modifying Data 

After adding data to a project, it may be necessary to modify the data before it is ready to 
be analyzed. The Filter and Query task can be used to modify a SAS data set in a variety 
of ways. 

1.5.1  Modifying Variables: Using Queries 
We begin with an example of creating a new variable from an existing variable. One 
common reason for creating a new variable is when a transform of an existing variable is 
considered necessary. The hardness variable in the water data set is somewhat skewed, 
so a log transformation might be appropriate.  
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  1.  Click on the water data set to make it active. There are two icons in the process flow   
       both named water. The SAS data set that we wish to use is distinguished by its  
       icon—the text file of the same name has a notepad icon. They can also be  
       distinguished by holding the cursor over them, which reveals additional details of  
       each.  

  2.  Select the SAS data set.  

  3.  Select Data Filter and Query. The opening screen should look like Display 1.12. 

Display 1.12  Query Builder Window 

   
 

The four variables in the input data set also appear in the Select Data pane because 
we have set the option to Automatically add columns from input tables to 
result set of query under Tools Options Query. Otherwise, variables from the 
input data set would need to be dragged across. It is worth noting in passing that the 
variables have icons that indicate whether they are character or numeric.  
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  4.  To create a new variable, select Computed Columns New Build Expression.  
       This brings up the Advanced Expression Editor window as shown in  
       Display 1.13. 

Display 1.13  Advanced Expression Editor 

   
 

The expression text specifies how the new variable is to be calculated. It can either 
be typed into the pane or constructed using the buttons and menus. Selecting the 
Functions tab shows a list of function categories with All Functions as the default. 
The right hand pane shows the functions by name, with a brief description of the 
highlighted function below.  

  5.  Scroll down this list, click on LOG and Add to Expression. LOG(<numValue>)  
       appears in the expression text. The <numValue> part indicates that the log function  
       takes a numeric argument.  

  6.  Because we want the log of the hardness variable, replace <numValue> with  
       hardness either by simply typing hardness in or by using the Data tab. If the Data  
       tab is used, the variable name will be prefixed with the name of the data set.  
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  7.  Clicking OK returns us to the Computed Columns window as shown in Display  
       1.14. The new variable is simply called Calculation1, by default, but can be  
       renamed by selecting it, clicking Rename, and typing in a more meaningful name,  
       such as loghardness. 

Display 1.14  Computed Columns Window 

   
 

Running the task adds an icon for the query and a new SAS data set to the process flow. 
The new data set contains the loghardness variable in addition to the original four 
variables. 

1.5.2  Recoding Variables  
Another common modification is to classify a continuous variable like hardness into a 
number of groups. Rather than create another Filter and Query task, we can re-open the 
existing one and add to that.  

  1.  Open the task by double-clicking on its icon, or by right-click Open.  

  2.  Select Computed Columns New Recode a column. 

  3.  Select hardness and Continue. The Recode Column window opens. 

  4.  Click on the Add button.  

  5.  Select the Replace a range tab.  

  6.  Use these to replace the ranges 0–15 with 1, 16–60 with 2, and 61–138 with 3. The  
       actual values of hardness contained in the data are available to view via the drop- 
       down boxes for the start and end of the ranges. The Recode Column window  
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       should now look like Display 1.15. Change the New column name to  
        hardness3groups as shown. 

  7.  Click OK, Close, and Run.  

  8.  Reply Yes to Would you like to replace the results from the previous run?  
       The Recode Column option within the Filter and Query task can also be used to  
       reduce the number of categories a categorical variable has, for instance when  
       combining categories which have too few members in. Such recoding can be done  
       with both numeric and character variables.  

Including multiple data modifications in the one Filter and Query task helps to keep 
the process flow diagrams simple and clear.  

Display 1.15  Recode Column Window 
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To modify the value of a variable for some observations and not others, or to make 
different modifications for different groups of observations, use the Advanced Expression 
Editor to build a query with a conditional function. A simple example is given in  
Chapter 2, Section 2.3.1. 

1.5.3  Splitting Data Sets: Using Filters 
So far we have looked at using the Filter and Query task to create and modify the values 
of variables and we used queries for the purpose. We now turn to the use of filters to 
produce subsets of the observations in a data set. We might want to form a subset of the 
observations in order to discard observations that have errors, or because we wish to 
focus our analysis on one particular group of observations. Take the water data set as an 
example where we want to look only at the northerly towns. Normally we would want to 
include the newly derived variables, and so we would use the data set calculated with the 
query described above. 

  1.  Click on the water data set to make it the active data set.  

  2.  Select Data Filter and Query.  

  3.  Click on the Filter Data tab.  

  4.  Location is the variable we want to filter on, so we drag and drop that into the  
       Filter Data pane. The Edit Filter window pops up.  

  5.  The value of location that we want to select is north. We could simply type that into  
       the value box, but it would be safer to use the drop-down button and select Get  
       Values.  

The reason for preferring Get Values is that filters which use character variables are case 
sensitive: North is different from north, so if both occurred in the data set, the filter 
would need to include both. Using Get Values would give us the correct spelling and 
case as well as alerting us to any misspellings that there might be in the data set.  

In our example here, the situation is straightforward and the Query Builder window 
should look like Display 1.16. A more complex filter can be constructed by clicking the 
new filter button (circled in Display 1.16) and selecting New Advanced Filter, which 
brings up the Advanced Expression Editor seen earlier. Another example of using filters 
to split the data set for separate analyses is given in Chapter 2, Section 2.2.2, and the 
process flow is reproduced in Display 1.4 above. 
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Display 1.16  Query Builder Window Filtering the Water Data Set 

   
 

1.5.4  Concatenating and Merging Data Sets: Appends  
          and Joins 

Where two or more data sets contain the same variables (or mostly the same) but 
different observations, they can be combined into a single data set using Data Append 
Table and specifying the table(s) to be concatenated with the active data set. 
Concatenation is essentially the converse of the process of splitting data sets described 
above. 

Where two data sets contain mostly the same observations but different variables, they 
can be combined to create a data set with all the variables using a join. Joins are yet 
another function of the Filter and Query task. We will illustrate a join again using the 
water data set. The original water data set has a variable, location, with values north 
and south. The version imported from the raw data has a variable, flag, where the value 
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‘*’ indicates the more northerly towns. To check that the two variables do in fact 
correspond, we will merge the data sets to produce one that has both variables.  

  1.  Make the imported data set the active data set.  

  2.  Select Data Filter and Query.  

  3.  Click Add tables. 

  4.  Select project as the location to open the data from. The list of similarly named  
       data sets shown in Display 1.17 illustrates the potential value of giving output  
       data sets explicit and more meaningful names. In this instance, the one simply  
       labeled water is the one we need.  

Display 1.17  List of Project Data Sets 

   
 

  5.  Select the water data set.  

  6.  Click OK. A Query Builder window like that shown in Display 1.18 opens. 
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Display 1.18  Query Builder Window for Join of Two Versions of the Water  
                       Data Set 

      
 

All the variables from the water data set have been added and, where they had the same 
name, the names have been suffixed with a 1 to make them distinct.  

  7.  Click on Join. The join is displayed, as  in Display 1.19, and can be  
       modified if necessary. 
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Display 1.19  Join of Two Versions of the Water Data Set 

   
 

The program has recognized that both data sets contain the variable town, which 
uniquely identifies each observation and can therefore be used to match them. The 
Venn diagram in the arrow connecting them shows that an inner join will be used. 
Right-clicking on the Venn diagram and selecting Modify Join lists the different 
types of joins and explains them. A choice will need to be made if the two data sets 
contain different observations. Here, the two data sets contain the same observations, 
so the type of join makes no difference.  

  8.  Close the Tables and Joins window. 

  9.  Use the buttons on the right of the Select Data pane to delete Town1, Mortal, and  
       Hardness1, and to move flag next to location.  

10.  Run the query. 

11.  Sort the resulting data set by location (Data Sort Data and Sort by location).  
       Scrolling down the results confirms that flag and location do indeed correspond. 
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The process flow should now resemble Display 1.20. It is beginning to look a bit 
confusing. Several tasks and data sets have similar names (beginning with “Query”) 
which do not give much idea of their purpose or contents.  

Display 1.20  Process Flow with Default Names 

    
 
Some of the tasks and data sets could be renamed (right-click Rename) to make this 
clearer. Display 1.21 shows an example. 
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Display 1.21  Process Flow with Renamed Tasks and Data Sets 

   
 

1.5.5  Names of Data Sets and Variables in SAS and  
          SAS Enterprise Guide  

Renaming some data sets and tasks in the process flow, as we did for Display 1.21, 
actually changed their labels rather than their names. Data sets, variables, and tasks all 
have labels as well as names, but there are different rules for creating names and labels.  

The SAS rules for names of variables and data sets:  

 Names are limited to 32 characters or less.  

 Names start with a letter or underscore ( _ ) and include only letters, numbers, 
and underscores. Names should not contain spaces.  

Although SAS Enterprise Guide has more flexibility in its naming, we recommend 
keeping to the SAS rules for variables and data sets.  
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Labels, in contrast, can contain spaces and other characters and can be up to 256 
characters long. However, when there is any doubt about which is being changed, it 
would be safer to leave spaces out and keep to the rules for SAS names.  

1.5.6  Storing SAS Data Sets: Libraries 
The SAS data sets created so far have been left with default names and locations. Some 
data set labels were altered to make the process flow easier to read. In most cases, it is not 
necessary to alter names and locations. When you want to control where project data sets 
are stored, use libraries. Essentially, a library is a folder where SAS data sets are stored. 
Rather than refer to the folder explicitly, the folder is assigned an alias: the library name. 
For example, the data sets created by the Import Data task were automatically given 
names like SASUSER.IMPW_xxxx. The part of the name before the period, SASUSER, 
is the library name and is an alias for c:\My SAS Files\9.1 on our system (it may vary 
depending on how SAS Enterprise Guide was set up). To store data sets in a particular 
folder: 

  1.  Assign a library name for that folder using the Assign Library wizard  
       (Tools Assign Library).  

  2.  Type in a name, which should follow the rules for data set names but be eight  
       characters or less; e.g., ch1.  

  3.  Add a description if required.  

  4.  When prompted, browse to the path of the folder; e.g., c:\saseg\libraries\ch1.  

  5.  Continue through the wizard accepting defaults and an Assign Library icon should  
       be added to the process flow.  

This needs to be run before the library can be used in the project, so it is best to set 
up the libraries at the beginning of the project. Having set up the library, any data set 
that is given a name beginning with ch1., such as ch1.water, will be stored in the 
folder c:\saseg\libraries\ch1. 

All SAS data sets are stored in a library. If a data set name is not prefixed with a library 
name, it has the implicit library name of WORK which, like SASUSER, is one of the 
libraries assigned automatically by SAS Enterprise Guide. However, WORK is a 
temporary library which means that data sets stored in it will be deleted and removed 
from the project when SAS Enterprise Guide is closed, although the option to move the 
data sets to another library is offered at that point.  
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1.6  Statistical Analysis Tasks 

Once data in a SAS data set have been added to a project, whether directly or by 
importing raw data, the analysis can begin. Individual tasks are described in detail in 
subsequent chapters. Here, we describe some general features of the analysis tasks.  

One point to bear in mind is that not all tasks that might be considered as analysis are 
under the Analyze menu. Several are accessed from the Describe menu, and some of 
the tasks under the Data menu could form part of an analysis. 

A typical analysis task consists of a number of panes, each of which allows some aspect 
of the analysis or set of options to be specified. We begin by looking at an example taken 
from Chapter 5. The process flow diagram is shown in Display 1.3. Opening the first of 
the Linear Models tasks gives the screen shown in Display 1.22.  

Display 1.22  Linear Models Task Opening Window 
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The panes are listed down the left: Task Roles, Model, Model Options, etc.  

The Task Roles pane, which is selected, is where the variables that are to be used in the 
analysis are selected and their roles in the analysis specified. The available variables are 
listed in the central section, and they can be dragged from there to the specific roles in the 
right-hand section. The available roles vary depending on the task, but some of the most 
common are included here:  

 The Dependent variable is the response variable, the one whose values we are 
modeling. The numeric icon to the left indicates that only numeric variables can 
be assigned this role and (Limit: 1) to the right indicates that only one response 
variable can be included in the model. The variable ChildIQ has been assigned 
this role.  

 Quantitative variables are also numeric. The dashed line around it shows that 
it has been selected (clicked on) and a description of the role appears in the box 
below, explaining that these are continuous explanatory variables. There are no 
variables assigned to this role.  

 Classification variables are discrete explanatory variables. They can be 
numeric or character. If they are numeric, classification variables will tend to 
have relatively few distinct values. Pa_history and Mo_depression are both 
assigned this role. 

 Group analysis by variables are also discrete, numeric, or character—variables 
which define groups in the data. When a variable is assigned this role, the 
analysis is repeated for each group defined by the variable. For example, if a 
variable, sex, with values male and female was assigned this role, the analysis 
would be repeated for males and females separately. We saw earlier how to use 
Filter and Query to split or subset a data set. If the reason for doing this is to 
apply the same analysis to separate groups of observations, then using Group 
Analysis by with a suitable variable could be both simpler and more efficient.  

 Frequency count variables are used with grouped data, where each observation 
represents a number of individuals. The frequency count variable is the one 
which specifies how many individuals the observation pertains to. The most 
common use is in analysing tabulated data. Examples are given in Chapter 3, 
Sections 3.4.3 and 3.4.4.  

 The relative weight role is for weighted analysis. 

Task panes like Model, Model Options, and Advanced Options, as their names imply, 
specify what model is to be fitted and how. They will be dealt with in detail in later 
chapters as they arise.  

Many analysis tasks also produce plots of data values, predicted values, residuals, etc., 
each of which may be specified in the Plots pane(s). 
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1.7  Graphs  

SAS Enterprise Guide also makes the powerful graphics facilities of SAS much easier to 
use. Some of these graphic facilities are available within analysis tasks and others are 
accessed from the Graph menu. A wide range of plots and charts are described in later 
chapters. Rather than describe the graph tasks here, the interested reader is referred to the 
index. 

One point to note, however, is that the graphs produced are dependent both on the format 
of the results and the graph format. Both formats are specified under 
Tools Options Results Results General and 
Tools Options Results Graph. One major difference is that, when the output 
format is RTF, the graphs are included in the same file as the textual output and tables; 
when HTML output is chosen, each graph appears in a separate file with its own icon in 
the process flow.  

1.8  Running Parts of the Process Flow 

So far, we have described running individual tasks. It is also possible to run a branch of 
the process flow or the whole process flow. If we right-click on any task within a process 
flow, we will have the option to run that task or to run the branch from that task. The 
branch is everything to the right of the task which is directly or indirectly connected to it 
by the arrows. To run the whole process flow, right-click on its tab and select Run. 

 
 




